Breathing Buildings NVHR®
Virtual Environment User Guide

Contents
1. Overview ............................................................................................................................................ 2
What is Breathing Buildings NVHR®? ........................................................................................... 2
Requirements for using NVHR in the Virtual Environment .......................................................... 2
2. NVHR Background .............................................................................................................................. 3
Product Information ..................................................................................................................... 4
Features ................................................................................................................................ 4
Options .................................................................................................................................. 4
Air Flow Strategies ................................................................................................................ 4
Installation and Control ........................................................................................................ 5
Find Out More ....................................................................................................................... 5
3. Using NVHR in the VE......................................................................................................................... 6
Introduction .................................................................................................................................. 6
Importing the NVHR units............................................................................................................. 7
Using the NVHR Grouping Scheme ............................................................................................... 8
Duplicating Unit Groups ........................................................................................................ 8
Deleting Unit Groups ............................................................................................................ 8
Editing Unit Group Properties............................................................................................... 9
Assigning NVHR to Rooms .......................................................................................................... 11
What happens when a room is assigned? .......................................................................... 13
What happens when a room is unassigned? ...................................................................... 15
Simulating with NVHR................................................................................................................. 16
Results Analysis........................................................................................................................... 18
4. NVHR and UK NCM analysis (Part L, Section 6, EPCs) ...................................................................... 19
The NCM framework .................................................................................................................. 19
Analysing the real building and the Actual Building ................................................................... 19
Appendix A:

Frequently Asked Questions ......................................................................................... 22

Appendix B:

About Breathing Buildings Ltd. ..................................................................................... 23

1

1. Overview
What is Breathing Buildings NVHR®?
Natural Ventilation with Heat Recycling (NVHR®) is the latest natural ventilation product from
Breathing Buildings Ltd. Natural ventilation is an important consideration for all new buildings. Good
air circulation ensures that occupants are comfortable and it is required as part of the Building
Regulations Part F. Additionally, with the environment, cost of energy and long term maintenance all
being areas of concern, any system should provide energy-efficient long term ventilation.
NVHR is the latest product from Breathing Buildings that is changing the way the industry thinks
about Natural Ventilation. The patented mixing ventilation system allows single-sided, natural
ventilation in deep plan spaces whilst making the most of internal heat gains to deliver superb
thermal comfort. This system allows buildings with limited façade and roof space to be naturally
ventilated. Its low energy mixing fans mitigate cold draughts in winter and provide boost in summer.
The system is fitted with external and internal temperature sensors that enable the system to create
an ideal working environment.
The units are designed primarily for offices and school classrooms and can be deployed in almost any
building due to their small size. They can work individually or as multiples (typically a pair for a
standard school classroom), directing air to the back of the space to provide a quasi-cross-flow
system. It is designed to meet the Department for Education “Guidance on ventilation, thermal
comfort and indoor air quality in schools” and the Facilities Output Specification (FOS) for the Priority
Schools Building Programme (PSBP). The units can be used with a grille or ducted arrangement to
supply air.
Further details on the units, air flow strategies and technical data is provided in this user guide (see
NVHR Background). For the latest details on the NVHR product or to discuss potential suitability for
your project, please visit http://www.breathingbuildings.com.

Requirements for using NVHR in the Virtual Environment
The Virtual Environment (VE) software includes built-in support for simulating both ducted and
ductless NVHR units from Breathing Buildings. However, in order to simulate you will need valid
licenses for the following VE modules:






ModelIT
Apache
MacroFlo
SunCast
ApacheSim

If you are missing one or more of these licenses, you will not be able to use the Breathing Buildings
functionality within the VE. Please contact keys@iesve.com for queries or support with licensing
issues.
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2. NVHR Background
Breathing Buildings was asked by a number of designers and contractors to provide a system which
delivered the benefits of controlled mixing ventilation but which enabled single-sided ventilation.
The challenge was further compounded by the request that the height to depth ratio of the rooms
being considered precluded them from being purely naturally ventilated throughout the year; either
spatial air quality variations or temperature variations would be experienced. The development of
the hybrid NVHR was therefore progressed to provide a controlled natural ventilation damper
arrangement which can be used on its own or in conjunction with opening windows, but combined
with fan-assisted flow and mixing when necessary. The designers were eager for a system to be
developed which was sufficiently slimline in vertical extent that it could either be easily incorporated
in a ceiling void or else if exposed would not negatively impact the natural daylighting provision from
typical window systems. Hence a 300mm deep unit was specified. Finally, in order to make the unit
small enough to be easy to install and to fit in a typical window system, a 900mm dimension was
selected for the width.
These slimline, easy-to-install, units are incredibly popular and have changed the world of low
energy ventilation. A critical feature for optimal use of the Breathing Buildings hybrid ventilation
strategy is that the climate should ideally be relatively temperate (winters not too severe) and
internal heat gains should not be low. When these criteria are satisfied, the Breathing Buildings
solution is more energy efficient than a mechanical ventilation heat recovery device because the fan
power usage in the NVHR is very low, and heat recovery is not helpful until external temperatures
during the occupied day fall to around zero degrees centigrade – which isn’t very often in temperate
climates. Below this temperature MVHR is potentially more efficient but above this temperature
NVHR is much more efficient, so that over the course of a whole winter the NVHR ends up being the
most efficient system.
The mixing ventilation system allows single sided, natural ventilation in deep plan spaces whilst
making the most of internal heat gains to deliver superb thermal comfort. It is designed to meet the
Department for Education “Guidance on ventilation, thermal comfort and indoor air quality in
schools” and the Facilities Output Specification (FOS) for the Priority Schools Building Programme
(PSBP). The unit can be used with a grille or ducted arrangement to supply air.
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Can work individually or as multiples (typically a pair for a standard school classroom)
System directs air to the back of the space to provide a quasi-cross-flow system
Mounted horizontally
Manual control with 4-position switch or fully automatic with override
BMS interface option to report T/CO2 or allow set-point changes and enable / disable
Automatic units switch between winter mixing, natural and summer boost modes and
include night cooling
Integrates with manual windows when it is above 16°C outside or can control actuators on
windows or dampers
In winter the units use internal gains to temper incoming ventilation air, rather than a
dedicated pre-heater, which has a significant impact in reducing heater sizing and energy
consumption







In a modern, well insulated building be it a classroom or well-occupied office environment,
there is an abundance of heat when ventilation demand is at its highest, and these units
capitalise on this
Can be used on noisy sites – a standard unit provides 26dB Dnew attenuation as
independently verified by SRL
Units can be exposed in a room or installed in a ceiling void
Very low energy consumption - typical specific fan power 0.13W/l/s in winter mode for unit
with grille

Product Information
Features
 Lightweight, plastic construction
 Low energy mixing fans to mitigate against cold draughts in winter
 Summer boost mode
 Night cooling mode
 Room temperature sensor with integrated CO2 sensor
 Internal mixed air temperature sensor
 External Temperature sensor
 Ready fitted mounting brackets
 Key switch for automatic operation; time override; long-term off; test
Options
 Manual or automatic control which responds to environmental conditions
 Weather louvre
 Additional sound attenuation for noisy sites through combination of acoustic louvres and
internal baffles depending on site specific requirements
 Control signal for automated actuation of low level windows or dampers
 Traffic light indicator panel for window opening
 Modbus link for integration into wider Building Management Systems (BMS)
 Heater coil for space heating (1.5kW per unit)
Air Flow Strategies
Natural Mode:




Damper opens
Single sided ventilation
Works with other openings in the space

Summer Boost:
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Damper opens fully
Air delivered to rear of the space
Natural exhaust through the unit
Night cooling

Winter Mixing:




Draught mitigation strategy
Mixes warm room air with fresh
external air
Natural exhaust through the unit

Installation and Control
The units are designed so that they can be exposed or enclosed in a bulkhead or ceiling void. The
slimline nature of the units was part of the design which was undertaken in collaboration with
Nicholas Hare Architects. When the units are exposed in the room or mounted in a bulkhead a grille
is usually provided to direct air towards the ceiling and back of the room. The grille arrangement
complies with the PSBP FOS. Exposed NVHR units can also be supplied with a fabric duct or solid
duct.

Exposed NVHR unit with a grille

Exposed NVHR with a solid duct

Exposed NVHR with a fabric duct

Diffuser grille arrangement above a suspended ceiling

Find Out More
For full details on NVHR, please read the datasheet or contact Breathing Buildings for further
information (see Appendix B: for contact details).
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3.

Using NVHR in the VE

Introduction
The integration of NVHR support into the VE provides a fast, streamlined and easy-to-use method of
simulating the effect of NVHR units within your VE building model. A dedicated Navigator is used to
guide you step-by-step through the automated process, from importing the units into your model,
configuring their operation, preparing and applying to rooms, thermal simulation and review of the
results.
To get started, click on the dropdown list of available Navigators at the top of the Navigators pane (if
the pane is not visible on the left side of the VE window, you can turn it on using the
button on
the application toolbar, or by selecting Navigator from the view menu). You will find a Breathing
Buildings NVHR® entry listed under the Partners section.

When selected, the Breathing Buildings NVHR® navigator will be displayed. This is what you will use
to go through the process of applying NVHR to your building, simulating and analysing the results.
In order to start using the navigator, you will need to
have a fully defined VE model already created and
loaded. This model should contain valid geometry
representing the building, and may also be set up with
valid data (e.g. heating set-points, cooling set-points,
Apache systems, internal gains, air exchanges, MacroFlo
openings) already assigned to the rooms. As the
assignment of NVHR to rooms will make direct
modifications to the assigned data, it is always
recommended that you make a back-up of your model
prior to commencing the NVHR integration – this will
allow you to have a baseline that you can easily revert
back to in the event of any issues. You can do this by
clicking the Make an archive of the current model before
making changes item in the navigator, or by selecting the
Current Project item from the File->Archive menu.
Once done, you will be ready to start with NVHR.
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Importing the NVHR units
To get started with NVHR, you will need to import the units into your building model. The units are
represented in the VE by components – when placed into a room, the room will automatically be
updated to make use of the NVHR unit. You can import the units by clicking on the Import the
required NVHR® systems from library item in the navigator – this will open the Add Components
From Library window with the Breathing Buildings NVHR® library pre-selected:

There are currently two types of unit that you can import into the VE – ducted or un-ducted. Details
on selecting which type of unit would be best suited for your usage are given in NVHR Background or
should be discussed with Breathing Buildings (see Appendix B: for contact details). You can review
the overview of each unit by clicking on it – this will also allow you to download the product
datasheet.
To import the units, click on the checkbox next to the type(s) you want, then click on the Import
Checked Components button. This will then copy the relevant component(s) into your model’s
component library, making them ready to be assigned to rooms. In addition to the unit(s)
themselves, the first import of an NVHR unit to the model will also import some typical ancillary data
that can be used when setting up your default room openings (louvres and windows) prior to
assignment:



Typical MacroFlo opening types for louvres and windows
Typical CDB constructions for louvres
Note: If you do not require these items, they can be manually removed from your model after import
using standard CDB and MacroFlo functionality if you have not already assigned them to
openings in the model.

Once the units have been imported, you can close the Add Components From Library window by
clicking on the Close button.
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Using the NVHR Grouping Scheme
Once you have imported one or both of the unit components from the library, a new Breathing
Buildings NVHR® room grouping scheme will be created in your model and automatically selected in
the room browser pane (if the pane is not visible at the bottom left of the VE window, you can
display it using the
menu).

button on the application toolbar, or by selecting Browser from the File->View

The NVHR grouping scheme is the mechanism
used to assign an NVHR unit to a room in the
model. The scheme contains one or more unit
groups representing each unit type you have in
your model – this will initially be the unit(s) you
imported using the previous navigator action. There is also a final unit group called No NVHR
Assigned – if a room is not being served by an NVHR unit, it is contained in this group (initially, all
rooms in the model will be in this group).
Duplicating Unit Groups
Since all rooms assigned to a particular unit group will share the same NVHR properties (i.e. number
of units in room, operation schedule, set-points and so on), you may want to create one or more
duplicates to allow the same basic type of unit (ducted or un-ducted) to be used with different
properties on each (e.g. a different number of units per room, or different setpoints). To duplicate a
group, right-click on it in the grouping scheme and select the Duplicate item – this will then create a
new unit group below the right-clicked group that can be edited and assigned to independently.

Deleting Unit Groups
If you have unit groups that are no longer required, you can remove them to avoid clutter. To
remove a unit group, right-click on it in the grouping scheme and select the Delete item.
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If there are one or more rooms currently assigned to the unit group, they will need to be re-assigned
before the group can be deleted. The software will prompt you to do this before you can proceed:

Clicking Cancel at this point will mean that the unit group is not deleted and the room(s) remain
assigned to it. Clicking OK will re-assign the room(s) to the alternative unit group and then then
remove the unit group.
All unit groups can be deleted (excluding the No NVHR Assigned group). Note that if the last “real”
unit group is removed, the grouping scheme itself will be automatically removed and the following
alert will be displayed:

The grouping scheme can be reinstated by importing one or both of the original components again.
Editing Unit Group Properties

You can view and edit the NVHR properties for each unit group (excluding the No NVHR Assigned
group) by right-clicking on the group item and selecting Properties. This will display the Component
Properties window, consisting of two tabs: Breathing Buildings NVHR® Properties and Information.
The Breathing Buildings NVHR® Properties tab allows you to control the settings that will be used to
simulate NVHR in each room that is assigned to the unit group, as well as edit the basics of the unit
group such as naming, number of units per room, whether it will highlight its assigned louvres and
windows, and its colour (displayed next to it in the grouping scheme and used by opening
highlighting and if the By Room Group option is selected in the View->Colour menu).
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Name: Allows you to change the name of the unit group. Editing this name will also update the
name of the associated component in the model’s component library.
In-use: Indicates whether the unit group is in-use (has one or more rooms assigned to it) or not in
use (has no rooms assigned to it).
Colour: Displays the colour currently used by the unit group for highlighting. Clicking on the colour
will display the standard colour picker window, allowing this colour to be changed.
Highlight NVHR® Openings: These options control whether rooms
assigned to this unit group will highlight their attached louvre(s)
and/or window(s). Louvres will be highlighted in full colour, while
windows will be highlighted in a lightened version of the colour.
Note that the opening highlighting is only displayed if the
Breathing Buildings NVHR® grouping scheme is active in the room
browser.
No. of units: Sets the number of NVHR units that will be simulated in each room assigned to this unit
group. This can be between 1 and 6 units (2 would be typical for a standard-sized classroom).
Operation: Lists modulating profiles (weekly or yearly only) that can be used to control the
operation of the NVHR unit(s) in the room(s) assigned to this unit group. By default, the filtering on
this list will only show profiles that include the Occupancy category or have no categories set. You
can change the filtering options by clicking the
button.
There is also an additional option Use Room Occupancy. When selected, this means that the
operation of the NVHR unit(s) will be determined by the occupancy profile for each assigned room.
Note that if an assigned room does not have a defined occupancy (i.e. an internal gain of type
People), it will be considered to be using off continuously (unoccupied).
CO2 Avg. Daily Target: Sets the average daily CO2 target in parts per million (PPM) for each room
assigned to the unit group.
Room Setpoint: Sets the temperature set-point for the occupied hours in room(s) assigned to the
unit group.
Night Cool Setpoint: Sets the temperature set-point for the unoccupied hours in room(s) assigned to
the unit group.
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Heating Night Setback: Sets whether a heating night setback strategy is used for room(s) assigned to
the unit group.
Windows Night Cooling: Sets whether windows night cooling is used for room(s) assigned to the unit
group.
Use Mechanical Cooling: Sets whether mechanical cooling is used for room(s) assigned to the unit
group.
Note that if there are already room(s) assigned to the unit group when you apply changes to one or
more of these values, the updates will be applied to all currently assigned rooms.
The navigator action Adjust NVHR® operating parameters for the imported systems (as necessary)
will simply cycle through all available unit groups, asking you whether you want to edit the
properties or skip:

This is equivalent to right-clicking on each unit group in turn and clicking on Properties.

Assigning NVHR to Rooms
With the appropriate unit group(s) set up and valid properties set (see previous section for details),
the unit groups are ready to be assigned to room(s) in your model. Note that in order to be valid for
NVHR assignment, any room must meet the following pre-requisites:
-

-

The room must have a wall with at least one external window that is assigned a MacroFlo
opening type that uses a Degree of Opening profile other than off continuously. Note that
ALL wall-based external windows that meet these criteria will be considered attached to the
NVHR unit(s) in the room.
The room must have a wall with at least one external door that is assigned a MacroFlo
opening type that uses a Degree of Opening profile other than off continuously. These doors
will then be treated as the louvres for the NVHR unit(s). Note that ALL wall-based external
doors that meet these criteria will be considered attached to the NVHR unit(s) in the room.

As modelling all non-NVHR attached windows and doors with off continuously (i.e. never opening) is
unlikely to be practical, the intended workflow is as follows:
1) Prior to beginning NVHR assignment, ensure that all external windows and doors in the
desired room(s) are assigned a MacroFlo opening type that uses off continuously as the
Degree of Opening profile.
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2) Select the window(s) and door(s) in each room that WILL be used by NVHR, and assign them
a MacroFlo opening type that uses on continuously as the Degree of Opening profile.
3) Assign the relevant rooms to NVHR (the active openings will then be highlighted).
4) Update the assigned MacroFlo opening types for the inactive doors and windows as
appropriate for your model.
The Breathing Buildings NVHR® navigator will attempt to guide you through this process. Use the
Prepare Model for NVHR® section actions to assist with this – they will allow you to create suitable
MacroFlo opening types for your needs (alternatively, you can use the standard types imported with
the original components – e.g. Louvres (on continuously), Louvres (off continuously) etc.), create
suitable CDB constructions (if desired), select openings and assign the relevant types using the
Opening Selection and Assignment utility in ModelIT. This will allow you to select doors or windows
(the tool operates on one or the other at any one time) either by click/drag in the viewport, or based
on criteria (e.g. area, orientation, slope). It then offers a quick route to assigning MacroFlo and/or
constructions onto the selected opening(s).
You designate a room to be served by NVHR by assigning it to the appropriate unit group in the
Breathing Buildings NVHR® navigator – this can be done by any of the standard methods (e.g. using
the
button above the room browser, or by using the Room Groups tab within Tabular Room Data
in ModelIT).
Once a room is assigned to an active unit group (i.e. a group other than No NVHR Assigned), the
room will display a Breathing Buildings logo in the viewport (as well as indicating which of the
openings are attached to the NVHR within that room) whenever the Breathing Buildings NVHR®
grouping scheme is active in the room browser. The logo will also display a small circle overlay at the
bottom-right, indicating the number of NVHR units being represented in that room:

If a problem is detected with the room set-up (e.g. there was no valid window or louvre to attach to
the NVHR), then an exclamation mark overlay will be displayed at the top-right of the Breathing
Buildings logo – if you hover over the exclamation mark with the select tool ( ) active, a balloon tip
will be displayed to indicate the problem with the room.
For example, if the room did not have any external window set with a Degree of Opening other than
off continuously:
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To correct this scenario, you must apply a valid (not off continuously) MacroFlo opening type to at
least one external window in the room (or to one external door, if the problem indicated that there
was no attached louvre). You can then either:
-

-

Assign the room to the same unit group again using the
button above the room browser.
This will re-attempt the assignment and should then correctly detect and attach the
opening.
Use the Ensure that all rooms assigned to NVHR® systems are valid navigator action. This will
go through all assigned rooms that are currently marked with an exclamation mark and
attempt to correct them.

Note that the presence of the exclamation mark does not indicate that the model cannot be
simulated – it simply indicates a problem with the NVHR set-up in that room, which may result in
inaccurate NVHR simulation results.
What happens when a room is assigned?
The act of assigning a room to an NVHR unit group makes a number of modifications to that room’s
assigned data, internal gains, air exchanges, MacroFlo opening types and Apache System, each with
the intent of setting up the room for an accurate simulation of NVHR. This will involve creating a
number of profiles based upon the specified operation profile. The exact modifications are
controlled by the properties of the unit group you have assigned the room to – modifications to
these properties after assignment will then cause the relevant values in the room to be updated
again.
The following modifications are made to the Room Data for the room:
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The Heating Profile will be set to on continuously.
The Heating Setpoint will be set to Timed and a suitable set-point profile created and
applied to the room, based upon the unit group’s operation profile and set-point values.
The Cooling Profile will be set to on continuously if the unit group has Use Mech. Cooling
active, otherwise it will be set to off continuously.
The Cooling Setpoint will be set to Timed and a suitable set-point profile created and applied
to the room, based upon the unit group’s operation profile and set-point values.
A modified copy of the room’s main Apache System will be created and assigned (see
below).

-

The System Outside Air Supply Variation Profile will be set to off continuously.
The Variation Profile for any existing Natural and Auxiliary Ventilation air exchanges in the
room will be set to off continuously.
One Machinery internal gain added to represent the electrical usage of the NVHR Supply
Fan.
One Auxiliary Ventilation air exchange added to represent the NVHR Supply Fan.
One Machinery internal gain added to represent the electrical usage of the NVHR Mixing
Fan.

The modifications for the room’s main Apache System are performed on a copy, as the system may
be assigned to room(s) that are not part of the NVHR unit group. However, if a suitable copy of the
system already exists, this one will be used instead (this is done to avoid bloating the Apache
Systems list for the model). The name of the copy will be prefixed with either NVHR® (Nat. Vent): or
NVHR® (Air Con.): depending on the Use Mech. Cooling setting in the unit group. The following
modifications are performed for the copied Apache System:
-

The Cooling/Ventilation Mechanism will be set to Natural Ventilation if the unit group has
Use Mech. Cooling active, otherwise it will be set to Air Conditioning.
If the unit group has Use Mech. Cooling active, the Changeover Mixed Mode Free Cooling
value will be set to Mechanical Ventilation.
The Auxiliary Energy Method will be set to Use SFPs.
If the unit group has Use Mech. Cooling active, the Air Supply Mechanism for fans will be set
to Other Local Ventilation Units, and the System Specific Fan Power (SFP) for fans will be set
to 0.0 w/l·s.

Similar to the Apache System, the modifications to the MacroFlo opening types applied to the
attached window and louvre openings in the room are performed on copies, as these opening types
may be applied to other openings in the model that are not attached to NVHR. Again, if a suitable
copy of the MacroFlo opening type already exists in the model, this one will be used instead to avoid
bloating. The name of the copy will be prefixed with either NVHR® (Louvre): or NVHR® (Window):
depending on the type of opening (door or window) it is being created for. The following
modifications are performed for the copied MacroFlo opening type:
-

If the opening type is being created for an external door, the Opening Category will be set to
Louvre.
A suitable profile will be created and set as the Degree of Opening Profile, based upon the
unit group’s operation profile, set-point values and CO2 daily target values.

When creating the Auxiliary Ventilation air exchange for the Supply Fan, the following values will be
used:
-
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The Reference will be called NVHR® Supply Fan, optionally suffixed by a number if necessary.
The Max Flow value will be set to 180.0 l/s, scaled by the number of units specified in the
unit group (e.g. for 2 units, the value will be set to 360.0 l/s)
A suitable profile will be created and set as the Variation Profile, based upon the unit
group’s operation profile, set-point values and CO2 daily target values. The formula data

within the profile will differ based on whether the unit group represents a ducted or unducted NVHR unit.
When creating the Machinery internal gain for the Supply Fan, the following values will be used:
-

-

The Reference will be called NVHR® Supply Fan, optionally suffixed by a number if necessary.
The Input Mode will be set to Watts (W).
The Maximum Sensible Gain and Maximum Power Consumptions value will be set to 180.0
l/s, scaled by the number of units specified in the unit group, then scaled by a design setting
SFP of 0.3 w/l·s at 20 Pa.
A suitable profile will be created and set as the Variation Profile, based upon the unit
group’s operation profile, set-point values and CO2 daily target values. The formula data
within the profile will differ based on whether the unit group represents a ducted or unducted NVHR unit.

When creating the Machinery internal gain for the Mixing Fan, the following values will be used:
-

-

The Reference will be called NVHR® Mixing Fan, optionally suffixed by a number if
necessary.
The Input Mode will be set to Watts (W).
The Maximum Sensible Gain and Maximum Power Consumptions value will be set to 80.0
l/s, scaled by the number of units specified in the unit group, then scaled by a design setting
SFP of 0.3 w/l·s at 20 Pa.
A suitable profile will be created and set as the Variation Profile, based upon the unit
group’s operation profile, set-point values and CO2 daily target values. The formula data
within the profile will differ based on whether the unit group represents a ducted or unducted NVHR unit.

Where profiles are automatically created, these will be marked as having a Data Source of Breathing
Buildings. These are not assignable through profile dropdowns, as they are automatically managed
by the VE and are only intended to be used by the automatic assignment process for NVHR. Whilst
you can make modifications to the profile values using ApPro, this is NOT recommended as it may
produce results that do not reflect the properties defined by the NVHR unit groups in the model. The
profiles may be automatically updated or deleted by making modifications to the properties of unit
groups in the room browser.
What happens when a room is unassigned?
The act of assigning a previously-assigned room to the No NVHR Assigned unit group will result in
the following modifications being made:
-
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NVHR Supply Fan internal gain and air exchange will be removed from the room.
NVHR Mixing Fan internal gain will be removed from the room.
All template-derived values for the room will be set back to From Template.
The MacroFlo opening types assigned to the window(s) and door(s) attached to the unit will
be reset back to the source opening type (i.e. the opening type that the automatic copy was
created from).

-

Any automatically created profiles, MacroFlo opening types, internal gains, air exchanges
and Apache Systems that are not in use will be removed from the model.

At this point, the room will no longer display the Breathing Buildings logo and the openings will not
appear highlighted.

Simulating with NVHR
Once you have assigned the rooms in your model to NVHR unit groups as appropriate (and then
performed any subsequent manual edits to room data, profiles, templates and so on), the model
should be ready to simulate. The relevant Navigator actions will be enabled when you click the
checkbox to the right of the Assign selected rooms to the appropriate NVHR® system action
(acknowledging that you have completed the action).

Note that the Make Manual Edits actions are optional – you will be able to continue without them.
However, it is recommended that you review these items prior to simulation to ensure that the
assigned options are valid for your model intent (particularly review the assignment of MacroFlo
opening types on windows and doors that are not assigned to the NVHR units, as these will have
been set as off continuously prior to NVHR unit group assignment).
In order to enable the Solar Pre-simulation and Thermal Simulation steps, you should perform the
Ensure that all rooms assigned to NVHR® systems are valid action – this will attempt to correct any
problems with the NVHR data on any room that is marked with an exclamation mark.
If one or more rooms could not be corrected automatically, an alert should display at the bottomright of the VE window indicating the number of rooms that need manual attention.

In this situation, you should review the problems for each invalid room by hovering the mouse over
each room’s exclamation mark – you can then take appropriate action to resolve the issue and then
retry this step. Once all assigned rooms are valid, the following alert should display at the bottomright of the VE window:
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You should then click the checkbox to the right of the Ensure that all rooms assigned to NVHR®
systems are valid action to enable the actions for Solar Pre-Simulation and Thermal Simulation.

You can then click the Simulate option under Solar Pre-simulation – this will switch the VE into
SunCast view and run the solar shading calculations.
Once completed, clicking the Simulate System action under Thermal Simulation will switch to Apache
view and prepare to run an Apache Simulation. In order to effectively simulate and view results for
the NVHR, the following simulation options are required:
-

Enable SunCast Link? should be active
MacroFlo Link? should be active
Auxiliary ventilation air exchange? should be active
Natural ventilation air exchange? should be active
All NVHR-assigned rooms should be selected for detailed output
Sensible internal gains breakdown should be active for detailed output

The Simulate System action will first check your current simulation options to see if they match these
desired values – if not, a message will be displayed to indicate this:

You can use the Show Details button at the bottom-left to display information on which setting(s)
are not at the expected value. If you would like the settings to be automatically updated to be
optimal for simulating NVHR, you can click the Update Simulation Options for NVHR® button –
otherwise, click the Use Existing Simulation Options button to continue with your current simulation
options.
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The standard Apache Simulation window should then appear, allowing you to configure which
period you want the simulation to cover. Once ready, you can start the simulation by clicking the
Simulate button.

Note that due to the requirement of detailed output for the assigned rooms, the simulation may
take some time to run. Once completed, you should switch to VistaPro to view and analyse the
results.

Results Analysis
Refer to the VistaPro manual for details on the use of this module; however, the following is typical:
Carry out common sense simulation checks:







Occupancy & gains operate at the desired times (line chart & table);
Set-points are correct at the desired times (line chart & table);
Auxiliary ventilation (NVHR supply fan) operates at the desired times (line chart & table);
Openings operate at the desired times (line chart & table);
Room temperature conditions do not lie outside of sensible limits (line chart & table);
Room CO2 conditions do not lie outside of sensible limits (line chart & table).

It is important that an appropriate number of NVHR rooms are assigned to a space; an insufficient
number of units can often be detected by poor CO2 performance.
Carry out design performance checks:
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Winter temperature test (range test < X°C (e.g. 20°C), occupied hours, heat map);
Summer low-level overheating test (range test > X°C (e.g. 23°C), occupied hours, heat map);
Summer comfort overheating test (range test > X°C (e.g. 25, 28°C), occupied hours, heat
map);
CO2 test (range test > X PPM (e.g. 1000 PPM), occupied hours, heat map);
Room temperature both when occupied and during night cool (line chart);
Operation of mechanical cooling if provided versus room temperature (line chart);
Active opening operation versus internal & external temperatures (line chart & table);
Energy use (line chart & summary table).

It is important that you review simulated operation and consider adjusting NVHR set-point values to
fine tune the design performance.
Carry out compliance performance checks:


CIBSE TM52 automated tests (see the VistaPro CIBSE TM52 Adaptive Comfort user guide)

4. NVHR and UK NCM analysis (Part L, Section 6, EPCs)
The NCM framework
Then National Calculation Methodology (NCM) is the framework defined by the UK Government for
the analysis of buildings and their systems for the purpose of analysis relating to Part L (for England,
Wales and Northern Ireland), Section 6 (for Scotland), and Energy Performance Certificates (for all
UK regions).
NCM analyses are governed by rules setting out the simulation methods to be used and the
conditions applying in those simulations. Setpoints, occupancy, DHW consumption, internal gains
and minimum ventilation rates are specified for a standardised set of building types and activities.
Systems are organised into categories, infiltration rates are calculated by approved methods, and
rules are laid down for the calculation of energy used by fans and pumps (‘auxiliary energy’). These
rules mean that conditions and methods used within the NCM framework to simulate the Actual
Building (a specialised NCM term) may differ from those applicable to the real building (the building
as designed, occupied and operated).

Analysing the real building and the Actual Building
The main sections of this document have described the approach to analysing the real building,
using simulation methods tailored to the detailed representation of NVHR systems.
In order to comply with the special requirements of NCM a modified approach is required. This
involves analysis of the Actual Building and the buildings which the software derives automatically
from it – the Notional Building and (for EPC purposes) the Reference Building. These analyses are
performed in the VE Compliance view of the VE, where tools are provided to facilitate the input and
editing of the additional data items.
Because some of the data required for NCM is shared with the analysis of the real building, NCM
analysis should be conducted on a copy of the real building model which is modified to
accommodate the NCM requirements.
In the VE Compliance view the NVHR units and logos are not displayed, and their place is taken by
provisions compatible with the NCM rules.
In this view, it is not possible to modify the assignment of rooms to unit groups. The standard Assign
Room Group window will notify you when this is the case:

19

Fan heat gains from NVHR systems will be ignored in NCM analyses, which use standard
prescriptions for room heat gains. The electricity consumption of the ventilation fans, must,
however, be accounted for.
To represent NVHR systems working in combination with the systems providing heating (and where
appropriate cooling) to the building, one or more Apache Systems must be created (or adapted from
their counterparts used for the real building). The characteristics of these systems should be entered
via the UK NCM system data wizard, starting with the selection of a suitable system type from the
UK NCM system type menu. Adjustments should then be applied to cater for the unique features of
the NVHR systems.
For heated-only rooms served by NVHR systems, Cooling/vent. on the Ventilation tab should be set
to Mechanical ventilation. In cases where the NVHR system provides all the ventilation, the Air
supply setting on the Ventilation tab of the UK NCM system data wizard should be set to Local
ventilation-only units, such as window/wall/roof units serving a single area. The natural ventilation
component of the system will be taken into account via SFP adjustments described below. It should
be noted that the aspects of the system which provide benefit in the form of reduced summertime
temperatures do not explicitly receive credit for this benefit under the current NCM Criterion 3 rules,
which in contrast to earlier editions of the Regulations are expressed exclusively in terms of reduced
solar gain. However, this aspect of performance will form an important part of the design as
assessed by the performance of the real building.
Any rooms for which an NVHR system supplements an air conditioning system should be modelled
with an appropriate air conditioning system type, and in this case Changeover mixed mode free
cooling on the Apache System Cooling tab should be set to Mechanical ventilation.
Set up this way, the system will be assessed for regulatory purposes against a comparable system in
the Notional Building.
Close attention should be paid to the settings on the System adjustment, Metering Provision and
System controls tabs of the UK NCM system data wizard, since these have a critical effect on
performance as assessed by the Regulations.
On the System tab of the Room Data dialog for each room served by an NVHR system:
System and Auxiliary vent. system should be set to the appropriate Apache System.
- DHW system should be set to the Apache System created for this purpose.
- Free cooling flow capacity should be set to the maximum volume flow rate that the NVHR
system is able to deliver to the room.
-
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- Is there mechanical supply in this room? (when present) should be ticked, and immediately
below it the checkbox Specific fan power should be set according to the principles
described below.
- Demand controlled ventilation Type should be set to Demand control based on occupancy
density (Cd = 0.85).
Fan power used by an NVHR system is represented within the NCM framework as a component of
auxiliary energy. This is the sum of contributions from pumps and fans. Pump power is a function of
system category and subject to limited user control. Fans fall into two categories – central and local
– for each of which a specific fan power (SFP) must be specified.
In the case of heating-only systems for which ventilation is provided locally the SFP parameter on
the Apache System dialog (System specific fan power (SFP)) should be set to zero and a suitable SFP
value entered on the System tab of the Room Data dialog for each room. This value should represent
the average SFP applicable to the room ventilation during operating hours, accounting for the fact
that for many hours the fan will be off. A suitable value (which will typically be very small) should be
derived from detailed simulations performed (under equivalent assumptions) for the real building.
Where heating and cooling is supplied by a separate system providing mechanical air distribution
there will be SFPs associated with the central system and/or the local air delivery. Where
appropriate these SFPs should be modified to take account of the small additional fan power
incurred by an NVHR system.
A separate Apache System, with suitable operation parameters, should be created to provide
domestic hot water (DHW), and assigned to the rooms for this purpose.
For the model used for NCM analysis, infiltration is set using parameters on the Building & System
Data dialog. MacroFlo analysis should be disabled by ensuring that the MacroFlo link? checkbox is
unticked on the Simulation Settings tab of the Building & System Data dialog.
With regard to the numerous other data inputs relating to NCM presented in the VE Compliance
view, reference should be made to the general guidance provided on this aspect of the software.
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Appendix A:

Frequently Asked Questions

Q: Why are some actions on the Breathing Buildings NVHR® navigator greyed out?
A:

If the action is greyed out but also has a small padlock icon shown on its checkbox ( ), this
indicates that you do not have a suitable view licence to carry out that action. See
Requirements for using NVHR in the Virtual Environment for more details on the licences
required to use the NVHR integration within the VE.
If the padlock is not displayed but the action remains greyed out, this means the action requires
you to tick one or more previous actions (therefore acknowledging that you have performed
them) before you can carry out the action.

Q: I have a number of rooms contained in one NVHR unit group. I want one of these rooms to use
slightly different NVHR properties (e.g. heating set-point) to the others – how can I do this?
A:

All rooms assigned to an NVHR unit group will share the same NVHR properties. If you want one
or more of the rooms to use tweaked values, you must create a duplicate of the unit group,
tweak the relevant values in that duplicate group, then re-assign the appropriate rooms to that
duplicate group instead. See Duplicating Unit Groups for guidance on how to achieve this.

Q: Can I have different NVHR units within the one room (e.g. a ducted unit and a ductless unit)?
A:

This is not currently possible – for modelling within the VE, a room can only be assigned to a
single NVHR unit group (and therefore a single unit type).

Q: Do I need to use the Breathing Buildings NVHR® navigator workflow to apply NVHR to my
model, or can I do it myself?
A:
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The navigator acts as a guide to best-practice and offers the most straightforward workflow for
applying NVHR to your model. However, you can import NVHR components from the source
library, assign rooms to the unit groups and so on without using the navigator. It is
recommended that you follow the navigator for convenience and practicality, unless you have a
specific situation where you need to do otherwise.

Appendix B:

About Breathing Buildings Ltd.

Breathing Buildings Ltd. was formed as a spin out company from the University of Cambridge in
2006, following the discovery and development of the proprietary low energy e-stack mixing
ventilation system as part of a major research programme at the BP Institute, through the
Cambridge-MIT Institute, with funding from BP plc. The technology was filed for patent by the
University of Cambridge, and Breathing Buildings has exclusive rights to the technology.
Breathing Buildings was set up to develop and commercialize this low energy ventilation system.
During 2006-07 prototypes of the system were developed and tested in the Breathing Buildings
laboratories, with a team of highly qualified ventilation experts. The value and potential of the
innovation has been recognised by several awards for innovation. Furthermore, since the e-stack
system was commercially introduced in 2007, the success of the product and associated consultancy
has been recognised by industry via an increasing number of awards.
E-stack systems are operating in hundreds of buildings across the UK, ranging from retail projects to
local primary schools, and there is a substantial pipeline of new projects for which Breathing
Buildings is actively engaged in supplying e-stack systems.
The Breathing Buildings team contributes significantly to research into natural ventilation. Our links
with the University of Cambridge are very strong. Click here for a reference list of background papers
and to watch Dr. Shaun Fitzgerald giving an introductory lecture on Natural Ventilation please click
here.
Contact Us:
Address:

Telephone:
Fax:
E-mail:
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Breathing Buildings,
Unit 3a, The Shade
Soham
CB7 5HF
United Kingdom
+44 (0)1223 450 060
+44 (0)1223 450 061
info@breathingbuildings.com

